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1. INTRODUCTION

1.1. BOT’N ROLL ONE A

1.1.1. BOT’N ROLL ONE A - TO WHOM IS IT FOR?

The Bot’n Roll ONE A Arduino compatible is an Open Source didactic product, which is intended for all
those who wish to start with mobile robots despite not having much knowledge about electronics or
computers. The assembly of this robot allows the first steps with some of the most common electronic
components. The brief introduction to the basic components and explanation of some concepts along
the assembly instructions allow a very enriching introductory approach that complements the electronic
components assembling.

Those who wish to get started in robotics find in Bot'n Roll ONE A the ideal tool to assemble a robot
while not having the basic knowledge on robotics.

Teachers will find the Bot'n Roll ONE A a working tool able to assist them in imparting knowledge to
their students. From electronic to programming, this robot allows the study of a wide range of concepts
in a very practical perspective.

The most experienced will find this robotic kit an interesting challenge. The Bot'n Roll ONE A has two
microcontrollers, one ATmega328 running at 16MHz, programmable in C language with Arduino IDE (like
an Arduino UNO) and one PIC18F45K22 running at 80MHz programmable in C with MPLABX Microchip
(supplied with firmware developed by botnroll.com). A library for the Arduino IDE specifically developed
by  botnroll.com  allows  interaction  between  the  two  microcontrollers.  This  kit  comes  with  an
alphanumeric LCD display with 2 two lines and 16 characters per line.

This  robot  can  be  coupled  with  a  wide  range  of  Arduino  compatible  shields  such  as  wireless
communications, GPS, GPRS, and many other sensors and actuators to perform various tasks, which
makes it  suitable to participate in the major national  and international  robotic competitions. These
competitions are always very inspiring for young people allowing them to see different solutions created
by other teams, a source of motivation willing them to learn more.

For more information, you can register on www.botnroll.com to keep you abreast of news.

©Copyright 2023, SAR - Soluções de Automação e Robótica, Lda. 4
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1.1.2. BOT’N ROLL ONE A MAIN CHARACTERISTICS

Microcontrollers: 1 ATmega328 + 1 PIC18F45K22

Supply Voltage: 7V to 15V DC

Digital I/O's: 14 (6 of which allow PWM)

Analog Inputs: 6 (ATmega328) + 8 (PIC18F45K22)

Dedicated Outputs for servo control: 2 (PIC18F45K22)

Encoders Inputs: 2 (PIC18F45K22)

I2C Connectors: 4 (ATmega328)

LCD Display: 2x16 Alphanumeric with contrast and light control (PIC18F45K22)

Push Buttons: 3 (PIC18F45K22)

Obstacle Sensors: 2 (PIC18F45K22)

Buzzer: 1 (ATmega328)

Debugging LED´s: 2

Motors: 2 (PIC18F45K22)

 Nominal Voltage: 12V DC
 Nominal Current: 0.58A
 Rotation without load: 285rpm
 Nominal Binary: 1.16Kg.cm
 Maximum Instantaneous Binary: 1.74Kg.cm

Dimensions: 205mm x 192mm x 85mm

Weight: 800g (base kit without battery)

Battery: Ni-MH AA 12V 800mAh 

Other characteristics:

 Reset Button;
 Circuit for measuring the battery voltage;
 Allows to include a voltage regulator dedicated to servo feeding;
 Microcontrollers communicate through SPI bus;
 Protection against short-circuit with a 4A slow fuse.

©Copyright 2023, SAR - Soluções de Automação e Robótica, Lda. 5
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1.1.3. BOT’N ROLL ONE A GENERAL OVERVIEW

©Copyright 2023, SAR - Soluções de Automação e Robótica, Lda. 6

Fig. 1: Bot’n Roll ONE A general overview
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1.2. ROBOTICS

1.2.1. HISTORICAL INTRODUCTION

The word "robot" was first used in a theatre play "RUR" (Rossum's Universal
Robots) written in 1920 by Karel Capek, a Czech playwright. In this piece, a
character built several artificial men and used them to replace men work. It
was the first time someone used this word to designate "artificial man". In its
original language, (Czech) "Robota" means, "forced labour". Perhaps due to
this secondary meaning, the robots are more associated with the industry.
Even before  this  piece,  the robots  were called  "Automan" by the Greeks,
whose meaning is "to move automatically."

1.2.2. THE THREE LAWS OF ROBOTICS

Created by the writer  Isaac Asimov in his fiction book  I, Robot these
laws dictate the expected behaviour of robots:

1st law:  a robot may not injure a human being,  or through inaction
allow a human being to come to harm.

2nd law: a robot must obey the orders given it by human beings, except
where such orders would conflict with the first law.

3rd  law:  a  robot  must  protect  its  own  existence  as  long  as  such
protection does not conflict with the first or second law.

According to Asimov, the main objective of  these laws was to make
possible the existence of intelligent robots (the laws presume enough
intelligence to distinguish between good and evil) in such way they
would  not  rebel  against  the  human  domain.  Later  on,  Asimov
introduced one more law:

Law Zero: A robot may not harm humanity, or, by inaction, allow humanity to come to harm.

However, law zero, has the serious problem of transferring the power to the robot (possibility) to assess,
in face of specific situations, if the interests of humanity overlaps the individual interest. Such possibility
opens a dangerous loophole for machines dictatorship, which would elect by themselves the highest
good, being even able to harm a human being should they understand that it is the best for humankind.

These are not exactly laws in the real sense of the word, but just guidelines that all robotics enthusiasts
and researchers implement when creating and developing robots.

©Copyright 2023, SAR - Soluções de Automação e Robótica, Lda. 7
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1.2.3. MAIN EVENTS AND SOCIETIES RELATED WITH ROBOTICS

RoboCup® - http://www.robocup.org/

The RoboCup is a Robot World Wide initiative for research and education, whose main objective is to
promote artificial intelligence and robotics in general. Having a football game as the main challenge,
new technologies are developed in all areas of robotics, so that a team of robots can win the human
world champions in the year 2050. Every year this event takes place in a different country.

S.P.R. - http://www.spr.ua.pt/site/

The  Sociedade  Portuguesa  de  Robótica  (Portuguese  Robotics  Society  also  known  as  SPR)  is  a  non-
profitable  association  whose  main  objective  is  to  promote  and  stimulate  education,  research  and
technological development, as well as industrial and servicing robotics applications.

F.N.R. - http://www.spr.ua.pt/fnr/

The  Festival Nacional de Robótica  (Portuguese Open) was first held in 2001 in  Guimarães, and has as
main objective to promote science and technology in junior and secondary schools, in the university
level,  as  well  as  in  the  general  public,  through  simple  and  entertaining  robot  competitions.  The
Portuguese Open, is held annually in a different city and it includes a symposium where national and
international researchers from the robotics field gather together to present the most recent activities of
their research work. This event is an initiative from the Portuguese Robotics Society and it has had an
incredible growth since its beginning, both in participants and in general public.

RoboParty® – http://www.roboparty.org/

The RoboParty® is an educational event that gathers teams of 4 people, during 3 days and 2 nights
(participants bring their sleeping bag) to teach how to build autonomous mobile robots in a simple and
entertaining way, supported by qualified tutors. Initially, a short course is given to teach the first steps in
electronics, robot programming and mechanical construction. Afterwards, a robotic kit developed by the
company  SAR  -  Soluções  de  Automação  e  Robótica  and  by  University  of  Minho  is  supplied  to  be
assembled by the participants (mechanics, electronics and programming), belonging to the team at the
end of the event. The tutors follow closely the team's work at all stages, in order to assure that every
robot works properly in the end.

In parallel, there are several leisure activities such as sports, music, Internet, games, parties, etc. Each
participant brings his sleeping bag and stays overnight during the whole event. 

The RoboParty® is identical to a LAN Party and it runs non-stop but with an educational and pedagogical
purposes. Rules of important national and international robotic competitions are shown and explained
so that youngsters can participate later on with the robot they build at RoboParty.

botnroll.com – http://www.botnroll.com/

botnroll.com develops educational products in the robotics field. The products are excellent educational
helpers for all those willing to start learning about robotics. Basic and secondary teachers can find in
these products the ideal tool to teach mechanics, electronics and programming in their lectures. For the
most experienced, there are also high technological mobile robotic solutions. 

©Copyright 2023, SAR - Soluções de Automação e Robótica, Lda. 8
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1.3. ELECTRONICS – DEFINITIONS

The electronics is the branch of science that studies the
use  of  circuits  consisting  of  electrical  and  electronic
components, with the main aim to transform, transmit
process and store energy. 

The electronics is the branch of physics that studies the
issue  and  the  effect  of  electrons  and  their  use  in
electronic devices.

Electronics  studies  essentially  the  electronic  flow  of
charges  through  the  semiconductor  (non-metallic

conductors). 

Electronics allows manipulating energy through flow, storage, distribution or conversion. It also allows
acquiring, processing, converting, filtering and storing information, through electrical signals.

Electronic Engineering consists on the application of the basic principles of electronic in technologies in
order to solve practical problems.

©Copyright 2023, SAR - Soluções de Automação e Robótica, Lda. 9
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2. BOT’N ROLL ONE A COMPONENTS

When you first open your Bot'n Roll ONE A kit verify that it contains the following components:

1- Two driving wheels
2- Two DC motors
3- Battery
4- USB Cable to connect the robot to the computer
5- Major electronics components
6- Mechanic components and caster wheel
7- Battery charger
8- Battery accessories for placing and connection
9- Acrylic base
10- Printed Circuit Board
11- Smaller electronics components

IMPORTANT NOTE:  Should  any  component be missing,  immediately  contact  the kit  supplier  for  its
replacement.

©Copyright 2023, SAR - Soluções de Automação e Robótica, Lda. 10
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3. BATTERY

Put  the  battery  to  charge  utilizing  the  charger  included  with  your  kit  before  you  begin  the  robot
assembly. This way the battery will be ready to use when you finish building your robot!

The provided battery is a Ni-MH (nickel metal hydride), 12V rated voltage and 800mAh rated current.

3.1. CHARGING THE BATTERY

Maximum Voltage: The battery is fully charged when its voltage stands between 14,5V and 15V.

Minimum Voltage: The battery is considered discharged when its voltage its lower than 10V.

Charging  Current: The  provided  charger  allows  you  to  define  the  battery  charging  current.  It's
recommended a current equal or less than one-tenth of the rated current, for a battery of 800mAh the
charging current must be: 800 / 10 = 80mA.

Charging Time: The charging time is determined by the battery capacity multiplied by a factor of 1.4 and
divided by the charging current: 800 x 1.4 / 80 = 14 hours. The battery must be disconnected from the
charger when it finishes its charging process.

Fast Charge: It’s possible to charge the battery with a current higher than the one above calculated, on
the other hand, this process may cause the battery to warm up and will decrease its lifetime.

Charging Cycles: You should avoid charging the battery for a few minutes or even a couple of hours, this
way you are shortening its  capacity  and its  lifetime.  Respecting the charging and discharging cycles
extends its longevity.

Polarity: Verify if you connect the charger with the correct polarity (“+” “-“)!

3.2. HANDLING THE BATTERY

Make sure the battery cable is properly attached to the robot before you plug the battery connector!
This prevents short circuits in your battery.

Never short circuit the battery terminals! This will destroy the battery and may even start a fire.

©Copyright 2023, SAR - Soluções de Automação e Robótica, Lda. 11
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4. BOT’N ROLL ONE A ASSEMBLY

The Bot'n Roll ONE A assembly is carried out in three steps:

1 – Mechanical Assembly
2 – Electronic Assembly
3 – Electrical Wiring

TIP: Put the battery to charge when you start building up your robot, so that after assembling it is ready
to use. It takes about 8 hours for a battery full charge. Do not leave the battery charging for longer than
8 hours otherwise you may damage it.  Since these are Ni-MH batteries you must perform complete
charges and discharges, rather than charging just a few minutes or even one or two hours. Short charges
reduce the battery capacity and its lifetime.

IMPORTANT NOTE: Some tools not included on this kit might be necessary, namely multimeter, PH1 and
PH2 Phillips  screwdriver,  flat  nose pliers,  soldering  iron,  soldering wire,  de-soldering  pump,  cutting
pliers.

4.1. MECHANICAL ASSEMBLY

For the mechanical assembly, you will need the motors, the wheels, the motors supports, hubs, screws
and the acrylic base.

Before you start assembling the robot, remove the
two protective plastic layers form the acrylic base!

©Copyright 2023, SAR - Soluções de Automação e Robótica, Lda. 12
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4.1.1. MOTORS

The setting of  each motor  is  performed using a motor
support  with two M3 embedded nuts,  three M3x6mm
PH1 screws and two M3x12m PH1 screws.

You  need  a  1.5mm  hex  wrench  included  in  the
mechanical  components  bag  and  a  Phillips  PH1
screwdriver (not supplied).

Fix  the  motor  to  the  support  using  the  three  smaller
M3x6mm PH1 screws.

Use  the  Phillips  PH1  screwdriver  to  tighten  all  three
screws conveniently.

Fix the support with the motor to the acrylic base using
the  two  longer  M3x12mm  PH1  screws  and  M3  nuts
embedded in the support. 

The acrylic base has a hole to pass the motors wires to
connect later on to the printed circuit board. Introduce
the wires into the hole according to the image.

©Copyright 2023, SAR - Soluções de Automação e Robótica, Lda. 13

Fig. 8: Fixing the L shape motor support to the
motor itself

Fig. 7: Required equipment to set
the motors

Fig. 10: Passing the motors wires through the
acrylic base

Fig. 9: Fixing the motors to the acrylic base
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4.1.2. DRIVING WHEELS

The  Bot'n  ONE  A  roll  moves  around  using  two  drive
wheels that are connected to the motors. They are made
of plastic with a rubber coating. 

In order to attach each wheel it is necessary to use an
engagement  "hub",  a  hexagon  M3x3mm  bolt  and  an
M4x6mm PH2 screw.

The motor shaft has a surface that is not round! Use this
flat area to mechanically lock the bolt hub and prevent it
to rotate on the shaft. This way you assure that all energy
from  the  motor  is  transmitted  to  the  wheels!

Fit the hub on the motor shaft and the hex bolt screws
against  the  flat  area  of  the  shaft  using  a  1.5mm  hex
wrench.

Insert  the  wheel  on  the  hub,  pushing  it  against  the
hexagonal tip of the hub.

Lock the wheel to the hub using the M4x6mm PH2 screw
and tighten it conveniently!

IMPORTANT  NOTE: Check  that  there  are  no  gaps
between the wheel and the motor as this will influence
the robot movement!

©Copyright 2023, SAR - Soluções de Automação e Robótica, Lda. 14

Fig. 11: Components to fix the driving wheels

Fig. 12: Assembling the driving wheels
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4.1.3. CASTER WHEEL

The caster wheel is necessary to support the robot and it
is used to adjust the inclination according to your needs.
Therefore, you have to adjust the robot height in its rear.

To place the caster wheel,  two M5x20mm PH2 screws
and six M5 nuts are used.

Insert the screws into the acrylic base and attach two M5

nuts on each screw. 

Place  the  caster  wheel  inserting  the  screws  into  the
corresponding holes and tighten the last M5 nut on each

screw. 

Use the M5 nuts  on each side of  the caster  wheel  to
adjust the inclination of the robot.

Check there are no loose nuts and that the caster wheel
aligns properly with the drive wheels as it influences the
movement of the robot.

Congratulations!  You finished assembling the mechanics of your Bot’n Roll ONE A!

You can move on to the electronic assembling.

©Copyright 2023, SAR - Soluções de Automação e Robótica, Lda. 15

Fig. 13: Caster wheel, bolts and nuts

Fig. 14: Assembling the caster wheel and
adjusting of the robot inclination



Bot’n Roll ONE A User Assembling Manual

4.2. ELECTRONICS ASSEMBLY

For the electronics assembly you require the following
tools (not supplied with the robot):

 Soldering iron
 Soldering wire
 De-soldering pump
 Cutting pliers

IMPORTANT NOTE:  In this stage, all electronic components are soldered to the Printed Circuit Board.
For a correct soldering process, we strongly recommend all components to be soldered sequentially as
presented in this manual. Bad soldering can cause destruction of components and printed circuit board,
therefore, before you start soldering you must read the “crash course on Soldering” available on Bot’n
Roll ONE A supplied manuals.

4.2.1. PRINTED CIRCUIT BOARD (PCB)

The Printed Circuit  Board (PCB)  contains  small
holes to insert the electronic components.

The  silk  screen  printing  (description  of
components in white) identifies the position and
orientation of each electronic component on the
Printed Circuit Board.

The Printed Circuit Board acts as a base for the
electronic  components  and  contains  all  the
connections  between  them,  according  to  the
wiring diagram of the robot.

You  must  insert  the  components  respecting  the  serigraphy  (white  letters)  but  solder  them on the
opposite side. It is not necessary to solder the components on the serigraphy side because the holes are
plated and therefore they allow the passage of electric current.

©Copyright 2023, SAR - Soluções de Automação e Robótica, Lda. 16

Fig. 15: Required material for electronics assembly

Fig. 16: Printed Circuit Board (PCB)
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4.2.2. RESISTORS

Electrical resistance is the name given to an element
that opposes the passage of electric current (direct or
alternating). 

Usually resistance is represented by the letter R and
its unit of measurement by the Ohm (Ω).

The nominal value is represented by coloured bands (colour code), which satisfies the following criteria:
exponent of the power of 10 that multiplies the original number, and finally the fourth colour (slightly
shifted to the right) corresponds to the tolerance in percentage.

Colour 1st Band 2nd Band 3rd Band 4th Band

1st Figure 2nd Figure Multiplier Tolerance %

Silver 0.01 +/- 10
Gold 0.1 +/- 5
Black 0 0 X 1 No colour +/- 20
Brown 1 1 X 10 Silver +/- 1
Red 2 2 X 100 Gold +/- 2
Orang 3 3 X 1,000 +/- 3
Yellow 4 4 X 10,000 +/- 4
Green 5 5 X 100,000
Blue 6 6 X 1,000,000
Violet 7 7
Gray 8 8 X 0.1
White 9 9 X 0.01

Table 1: Resistance colour codes

Example: What is the value of the resistor on the picture?

The first two colours: yellow (4) and violet (7) form the number 47.
The  third  colour,  orange  (3),  corresponds  to  the  exponent  of  the
power of ten: 103, or multiply by 1000, the fourth colour, silver (10%),
indicates the tolerance. Thus, the electrical resistance is:

R = 47000Ω with 10% tolerance or R = (47 000 Ω ± 4700Ω)

©Copyright 2023, SAR - Soluções de Automação e Robótica, Lda. 17

Fig. 17: Resistance – lines with colour codes

Fig. 18: Resistor example
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Taking  as  reference  the  following  table,  solder  the  resistors  in  the  corresponding  locations  on  the
printed circuit board:

Solder the resistors value 1KΩ ±5%
(Colours:  Brown,  Black,  Red and Gold) on R1, R6, R7, R8, R13, R14, R16,
R17, R18, R19, R20, R22 and R23;

Solder the resistors value 10KΩ ±5%
(Colours: Brown, Black, Orange and Gold) on R3, R4, R5, R11 and R12;

Solder the resistors value 120Ω ±5%
(Colours: Brown, Red, Brown e Gold) on R15, R24 and R25;

Solder the resistor value 1MΩ ±5%
(Colours: Brown, Black, Green and Gold) on R21;

Solder the resistors value 3,3KΩ ±5%
(Colours: Orange, Orange, Red e Gold) on R2, R9 and R10.

Tip: First, place all the resistances in the
proper  places  slightly  bending  the
terminals of each resistance. 

Press  the  resistance  against  the  desk
before applying the solder process. 

After soldering cut the terminals as short
as possible to avoid short-circuits.

©Copyright 2023, SAR - Soluções de Automação e Robótica, Lda. 18

Fig. 20: Resistors on the Printed Circuit Board

Fig. 19: Bot'n Roll ONE A resistors

Description Component
R1 1 KΩ
R2 3,3 KΩ
R3 10 KΩ
R4 10 KΩ
R5 10 KΩ
R6 1 KΩ
R7 1 KΩ
R8 1 KΩ
R9 3,3 KΩ
R10 3,3 KΩ
R11 10 KΩ
R12 10 KΩ
R13 1 KΩ
R14 1 KΩ
R15 120 Ω
R16 1 KΩ
R17 1 KΩ
R18 1 KΩ
R19 1 KΩ
R20 1 KΩ
R21 1 MΩ
R22 1 KΩ
R23 1 KΩ
R24 120 Ω
R25 120 Ω
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4.2.3. CRYSTAL OSCILLATOR

A  crystal  oscillator  is  an  electronic  component  that  uses  the  resonant
properties of a piezoelectric crystal,  to create an electrical signal with a
very precise frequency. Bot'n Roll ONE A uses a 16MHz quartz oscillator
crystal  which  makes  the  IC  ATmega328  to  operate  at  a  16MHz  clock
frequency. Like traditional watches, which also use a crystal, the usage of a
crystal makes the Bot'n Roll ONE A a very accurate machine to measure

time. 

On  the  printed  circuit  board  serigraphy,  the  crystal
oscillator is represented by “XTAL”.
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Fig. 21: Crystal Oscillator

Fig. 22: Crystal Oscillator on the board

Description Component
XTAL Crystal 16MHz
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4.2.4. DIODES

The  conventional  diode  consists  of  two  blocks  of  semiconductor
material, a N-type doped with negative ions (-), and a P-type doped with
positive ions (+).

As main characteristic, the diode allows the electric current to flow only
in one direction (left to right as shown in the picture).  

To  indicate  the  polarity,  the  diode  has  a  mark  that  points  to  the
corresponding edge of the cathode. The electric current flows from the
anode (+) to the cathode (-) and not in reverse.

The Zener diode differs from the conventional diodes in being able to
drive  in  both  directions  (direct  and  reverse),  in  controlled  situations,
without  damaging  itself.  The  Zener  diode  has  an  associated  reverse
voltage that remains constant in a situation where the current flows in
the opposite direction. This allows it to be used in Bot'n Roll ONE A as a
protection element in  the battery measurement circuit.  It  works  as  a
voltage limiter. To its terminals, voltage never rises above 5.1 V and thus
the PIC18F45K22 will never be damaged in case the battery accidentally
has excessively high voltages.

The board uses two different diodes with references:

FR203,  used  to  drive  the  motors  and  to  protect  the  power
circuit of the robot.

Zener  5v1,  used  as  a  protection  element  in  the  battery
measurement circuit.

The diodes have polarity,  and therefore, must be placed with
the correct orientation! Each diode has a mark that must match
with  the  mark  represented  on  the  serigraphy  of  the  printed
circuit board (Fig. 26: Diodes location). 

The diode reference is printed on the component itself.

Place the Zener diode 5V1 on Z1.

Place the FR203 diode on positions: D1, D2, D3, D4, D5, D6, D7,
D8, D9, D10, D11 and D12.

©Copyright 2023, SAR - Soluções de Automação e Robótica, Lda. 20

Fig. 26: Diodes location

Fig. 23: Diode

Fig. 24: Zener Diode

Fig. 25: Robot Diodes

Description Component
D1 FR203
D2 FR203
D3 FR203
D4 FR203
D5 FR203
D6 FR203
D7 FR203
D8 FR203
D9 FR203
D10 FR203
D11 FR203
D12 FR203
Z1 Zener 5v1
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4.2.5. POTENTIOMETERS

A potentiometer is a variable resistor, i.e., its value can be adjusted, and this way, one
can control the intensity of the current flowing in a given circuit. In Bot'n Roll ONE A,
potentiometers  allow  adjustment  of  the  obstacles  sensor  detection  distance,  the
contrast and brightness of the LCD display.

The printed circuit board has four 10KΩ potentiometers.

Its value is written on the side, as explained on  Fig. 28:
Potentiometers.

The inscription P 103 corresponds to 10 000Ω, i.e., 10 KΩ.

The  IRD1  potentiometer  regulates  the  left  obstacle
sensor detection distance.

The  IRD2  potentiometer  regulates  the  right  obstacle
sensor detection distance.

The  BR potentiometer  regulates  the  LCD display
brightness.

The CT potentiometer regulates the LCD display contrast.
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Fig. 28: Potentiometers

Fig. 27: Potentiometers

Description Component
IRD1 Potentiometer 10KΩ
IRD2 Potentiometer 10KΩ
BR Potentiometer 10KΩ
CT Potentiometer 10KΩ

http://es.wikipedia.org/wiki/Archivo:Potentiometer_symbol_Europe.svg
http://es.wikipedia.org/wiki/Archivo:Potentiometer_symbol.svg
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4.2.6. COLOURED LEDS

An  LED  –  Light  Emitting  Diode,  consists  of  a  PN  junction  of  a
semiconductor material and two terminals, the anode (A, positive
terminal) and cathode (K, negative terminal). 

The  colour  of  the  light  emitted  by  the  LED  depends  on  the
semiconductor material.

Like the diode, the LED has polarity. The flat spot identifies the
cathode (-) and is associated with the shorter leg.

Warning: Never look directly to the light emitted by an LED. At a
short distance, the light is strong enough to injure the retina and
the damage is permanent!

The Light Emitting diodes (LED’s) indicate the status of your
Bot’n Roll ONE A.

The green LED ON indicates that the robot powered. 

The yellow LED’s are for “debugging” and are controlled by
your program.

The  red  LED's  are  associated  to  the  obstacles  detection
circuit.

Place the green LED where  ON is indicated in
the PCB.

Place the yellow LED's on L and LED.

Place the red LED’s on IRS1 and IRS2.

IMPORTANT NOTE: Do not forget that the LED’s have polarity! You must insert the longest leg of each
LED on the “+” indication on the board.
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Fig. 30: LED’s

Fig. 29: LED

Description Component
ON LED green
L LED yellow
LED LED yellow
IRS1 LED red
IRS2 LED red
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4.2.7. INTEGRATED CIRCUIT SOCKETS

The sockets for integrated circuits allow easy replacement of the
integrated  circuits  in  case  they  are  damaged.  Never  solder
integrated circuits directly on the PCB!

There  are  two sockets  to  insert  the ATmega328  and
PIC18F45K22 integrated circuits. These sockets have 28
and 40 pins respectively. 

Each socket has a slot at one end that should match the
serigraphy on the board. The placement of the sockets
must  respect  these  slots  because  they  are  very
important  in  inserting  the  integrated  circuits.  The
integrated circuits also have that slot.  If you insert an
integrated circuit  in  the wrong orientation,  you will
damage it permanently!

The sockets must be soldered on U1 and U2.

IMPORTANT NOTE: The ATmega328 and PIC18F45K22 integrated circuits will be inserted later in the
sockets. Should only be inserted in step 3.3.4 after wiring the board.
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Fig. 31: Integrated circuits sockets

Description Component
U1 28 pins socket
U2 40 pins socket
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4.2.8. INFRARED EMITTERS

Infrared  emitters  are  LEDs  that  emit  infrared  light.  This
light is not visible to the human eyes, but it causes damage
to the retina as in conventional LEDs!

Using a video camera, like a web cam for example, one can
check whether the LEDs are working or not.

The infrared emitters are used in the obstacle detection
circuit. They emit light that is reflected by the obstacles.

Place the infrared emitters  on positions  IRE1 and  IRE2
facing outwards. 

4.2.9. PUSH BUTTONS

 A push button places an electrical  signal on the circuit  while
being pressed.

Four push-buttons allow you to interact with the robot.
You  can,  for  instance,  navigate  on  menus  and  change
settings on your program quickly and without connecting
your robot to the computer.

Use the push buttons PB1, PB2 and PB3 to interact with
your robot and to navigate on menus displayed on the
LCD.

The Reset push button resets the Arduino.
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Fig. 32: Infrared emitters LED's

Fig. 33: Push buttons

Description Component
IRE1 Infrared emitter
IRE2 Infrared emitter

Description Component
PB1 Push button
PB2 Push button
PB3 Push button
Reset Push button
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4.2.10. MAIN SWITCH

 A switch is a device that interrupts the power supply (electric
current) to the circuit.

The main switch allows you to power the robot ON
and OFF.

It must be soldered on SW "Switch".

Bot'n Roll ONE A will be powered ON when you slide
the switch to the front side of the robot. It will be OFF
if you slide the switch back!

4.2.11. BUZZER

The  buzzer is a transducer that converts electrical pulses into
sound.

The buzzer can be used to create melodies or warning
sounds, for example, to indicate that the battery voltage
is too low.
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Fig. 35: Buzzer

Fig. 34: Main switch

Description Component
SW Main switch

Description Component
Buzzer Buzzer
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4.2.12. CERAMIC CAPACITORS

The capacitor is a component that stores energy between two conducting
plates (E=1/2CV2). It is used to stabilize the energy on the robot circuits.

The  capacitance  (C)  relates  the  stored  charge  with  the  voltage  at  its
terminals (C=Q/V). The capacitor is made up of two conductive plates that
are separated by an insulator or dielectric.

There are monolithic capacitors (no polarity - left) and electrolytic (with
polarity - right).

Bot'n  Roll  ONE  A  uses  ceramic  capacitors  with  two
distinct values: 22pF and 100nF.

The  22pF  capacitor  has  the  legend  22  and  the  100nF
capacitor has 104K written on it.

Place the 100nF capacitors on C1, C2, C3, C7, C8, C11 and
C12.

Place the 22pF capacitors on C9 and C10. Note that 33pF
capacitors can also be used as an alternative!
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Fig. 37: Ceramic capacitors

Fig. 36: Capacitor

Fig. 38: Capacitors location

Description Component Inscription
C1 100nF 104K
C2 100nf 104K
C3 100nF 104K
C7 100nF 104K
C8 100nF 104K
C9 22pF 22
C10 22pF 22
C11 100nF 104K
C12 100nF 104K
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4.2.13. BIPOLAR TRANSISTORS

A transistor is a semiconductor device used to amplify or switch electrical signals. On Bot'n Roll ONE A it
is used in the obstacles detection circuit to increase the power of the light emitted by the infrared LED's.

It consists of three layers of semiconductor material of P and
N types and has three terminals:  Emitter, Base and Collector.
The provision of the three layers P and N set to  PNP or  NPN
transistor. 

When used as an amplifier, the current flowing between the
base  and  emitter  (input)  is  amplified  and  manifests  itself
between collector and emitter (output). When the transistor
acts as switch, the base input signal toggles the output signal.
Depending on the transistor connection configuration, the amplified or toggled signal in the output
can be inverted or not, regarding the input signal.

The two PNP BC557 transistors are placed on Q1 and Q2.

These components are present in the infrared
emitter  circuit,  working as  switches,  allowing
the  PIC18F45K22  to  turn  OFF  and  ON  the
infrared  LED's  with  high  power.  Thus,  the
obstacles can be detected at great distances! 

Transistors have polarity! Only work properly if placed correctly in the circuit.

You must match the flat surface of the transistor with the flat line on the board´s serigraphy.
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Fig. 40: BC557B PNP Transistor

Fig. 39: NPN bipolar transistor

Description Component
Q1 BC557 Transistor
Q2 BC557 Transistor

http://en.wikipedia.org/wiki/File:NPN_BJT_(Planar)_Cross-section.svg
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4.2.14. JUMPERS

A  jumper  is  a  connector  that  allows  you  to  electrically
configure  the  robot,  directing  the  electric  current  to
certain areas of the circuit.

Bot'n Roll ONE A has one 2-positions jumper and two 1-position
jumpers.

The  2-positions  jumper  SPOW "Servo  Power"  allows  you  to
select  whether  the  servos  are  powered  by  the  7805 voltage
regulator or the PWR voltage regulator dedicated to the servos.

The BUZ jumper connects the buzzer to the I/O pin 9 of Arduino.

The  SSP jumper,  when  connected,  allows  communication
between the Arduino and the PIC using the I/O pin 2 of Arduino
as "Slave Select" of the SPI communication bus.
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Fig. 41: Jumpers

Description Component
SPOW 2-positions jumper
BUZ 1-position jumper
SSP 1-position jumper



Bot’n Roll ONE A User Assembling Manual

4.2.15. ARDUINO CONNECTORS

The  set  of  five  connectors  allows  the  connection  of
Arduino Compatible  “shields”,  like  the wireless  XBee
communication shield.

Solder each of the five connectors on the rows with the
same number of pins as the connector. Check that they
are  properly  aligned  and  touching  the  printed  circuit
board! 

Each  of  the  five  Arduino  connectors  has  its  specific
function:

The  VIN-IOREF connector  is  the  Arduino Power
connector. All robot circuit voltages are available here:  

5V,  3.3V,  VIN (battery voltage)  and  GND (0V).
The RESET pin is connected to the Arduino Reset button
and the IOREF is reserved for future shields.

On the A0-A5 connector are located the analog inputs of
the Arduino Analog to Digital Converter (ADC). Here you
can connect analog sensors whose signal vary between
0V and 5V. With just some lines of code, you can get the
corresponding  digital  value.  Should  you  use  I2C
communication you cannot use the  A4 and  A5 pins as
inputs for the ADC, since they are reserved for the I2C
communication.

Next to the  A0-A5 connector, you will find a group of triple connections that have the same  A0-A5
identification. Here you can connect analog sensors that also require voltages between 0V and 5V. On
this group of connectors the "s" pins correspond to the analog inputs, "-" corresponds to the 0V and "+"
corresponds to 5V.

On the  0-7 and  8-SCL connectors, you have the Arduino digital inputs and outputs (I/O) and each of
these pins can be configured by software as a digital input or output. On each of the 0 to 13 outputs, you
can place a 0V or 5V signal that correspond to the Low and High states respectively. On the pins with the
symbol "~", for example ~3 you can have a PWM output and here you can control servomotors, like the
ones used on the gripper. When configured as digital inputs, to connect digital sensors for example, on
each of these pins you can check whether you have 5V or 0V. The SCL and SDA pins are used for I2C
communication and corresponds to A4 and A5 pins of connector  A0-A5. The AREF pin should only be
used in case you require an external reference voltage for the ADC conversions, but this voltage can only
vary between 0V and 5V!

Next to the  0-7 and  8-SCL connectors, you will find a group of triple connections that have the same
identification  0-7 and  8-SCL. Here you can connect digital sensors and actuators that require voltage
between 0V and 5V. On this group of connectors the "s" pins correspond to the digital pins, the "-"
corresponds to the 0V and the "+" corresponds to 5V.

The ICSP connector allows SPI communication with shields and the ICSP (In Circuit Serial Programming)
programming of the Arduino bootloader.
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Fig. 42: Arduino connectors

Description Component
ICSP 2x3 male connector
A0-A5 1x6 female connector
VIN-IOREF 1x8  female connector
0-7 1x8  female connector
8-SCL 1x10  female connector
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4.2.16. POWER CONNECTORS

 The  power  connectors  allow  you  to  connect  the
battery  and  motors  to  the  PCB.  Screws  secure  the
wires.

Join the connectors using the slots so that you have a six
links unique connector.

Fit it and solder all terminals on the PCB.

On  MotorL you connect the left motor, on  MotorR you
connect  the  right  motor  and  on  Bat you  connect  the
battery.

4.2.17. FUSE AND FUSE HOLDER

A fuse is a protective device comprising a metallic conductor
that melts as soon as the electric current flowing through it
exceeds the specified value.

To protect against short circuits a 4A fuse with a fuse-
holder  is  used.  If  the  electric  current  supplied  by  the
battery exceeds 4A, the fuse will burn.

Place the 4A slow blow fuse on the fuse support cover.

The  fuse  holder  must  be  inserted  in  the
printed circuit board on “F1”.

Insert the fuse cover with the fuse on it. 
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Fig. 43: Power connectors location

Fig. 44: Placing the fuse in the circuit

Description Component
MotorL Left motor connector
Bat Battery connector
MotorR Right motor connector

Description Component
F1 Fuse support
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4.2.18. ELECTROLYTIC CAPACITORS

Electrolytic  capacitors  have  polarized  terminals! As  such,  when
placed  on  the  printed  circuit  board,  you  have  to  respect  their
polarity.

They should  be placed on  C4  and  C5  with  the longest
terminal  inserted  into  the  location  identified  by  the

symbol "+" on the serigraphy. 

The capacitors value is 100μF.

4.2.19. I2C CONNECTORS

These connectors allow you to plug devices that use I2C
communication protocol  like  compasses,  accelerometers,
sonar, temperature and humidity sensors, etc.

Place the connectors on I2C1 and I2C2. Note that the
mark in the serigraphy represents the vertical plastic

of the connector. 

4.2.20. USB - SERIAL CONVERTER

 The USB – Serial (RS232) converter is the device which allows
programming the robot through a computer USB port.

This  device  is  placed  on  the  ”USB”  mark  of  the
serigraphy.
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Fig. 45: Electrolytic capacitors

Fig. 47: USB converter

Fig. 46: I2C connectors

Description Component
C4 100µF
C5 100µF

Description Component
I2C1 KK 1x4 male connector
I2C2 KK 1x4 male connector

Description Component
USB USB converter
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4.2.21. HEAT SINK

A  heat  sink  is  a  metallic  object  that  reduces  the  working
temperature of a component.  It  avoids the component to be
damaged  due  to  excessive  temperature  and  increases  its
lifetime.

Attach the LM7805 to the heatsink using the bolt and nut
provided. Put together the smooth inner surface of the
heatsink sink, and the metallic surface of the LM7805!

4.2.22. VOLTAGE REGULATORS

 The  LM7805  and  LD33CV  components  are  linear  voltage
regulators to supply specific voltages for powering the circuit.

 The 7805 serves as a power source for devices that work at 5
volts while the LD33 power devices that work at 3.3 Volts.

According to the serigraphy, place the LM33CV where indicated
“LD33” and the LM7805 where indicated “7805”.

You must solder the LM7805 with the heat sink already placed!

Components  orientation  must  be  respected.  Note  that  the
double line on the serigraphy corresponds to the metallic heat
sink of the component.
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Fig. 49: LD33 and 7805 Voltage regulators

Fig. 48: Heat sink

Description Component
7805 LM7805
LD33 LD33CV

Description Component
7805 LM7805
LD33 LD33CV



Bot’n Roll ONE A User Assembling Manual

4.2.23. L298 H BRIDGE

The  L298N  component  corresponds  to  a  double  H  bridge  to
drive, independently, each motor of the robot, allowing control
of speed and direction.

This  component allows  a  maximum current  of  2A on each H
Bridge for continuous operation. For short moments (up to 100
us), it enables a 3A debit for each motor.

Place the L298N on “U3”. 

4.2.24. INFRARED RECEIVERS

The infrared receivers are sensors that detect infrared light
reflected by obstacles. This light is emitted by the infrared
LEDs as a 56 KHz modulated signal, i.e. each LED turns on
and off 56,000 times per second! If the LEDs do not emit at
this frequency the infrared receiver sensors will not detect
obstacles.

Two infrared receivers are placed at the  bottom  of
the printed circuit board, unlike all  the components
already soldered.

Insert the VISHAY TSSP4056 receivers under the PCB
on  IRR1 "Infra-Red  Receiver1"  and  IRR2,  with  the
sensors facing outwards as illustrated on figure 49.

These receivers must be soldered on the top side of
the PCB, opposite to what you have done so far. 
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Fig. 50: L298N integrated circuit

Fig. 51 Infrared receivers

Description Component
U3 L298N

Description Component
IRR1 VISHAY TSSP4056
IRR2 VISHAY TSSP4056
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4.2.25. LCD

The LCD is a device that enables the robot to interact with the
user  through  written  messages,  for  example,  states  of  the
program or the value of variables.

The Bot'n Roll ONE A LCD is alphanumeric, has 2 lines with 16
characters each. It has adjustable contrast and brightness.

To hold the LCD a 16 pins header connector, two M3x10
PH1  screws,  two  nylon  spacers  and  two  M3  nuts  are
provided.

To attach the LCD you have to remove the piece of plate
that  fills  the  output  hopper.  Use  a  file/sandpaper  to
smooth the output hopper, if necessary, so that the LCD
enters effortlessly.

The LCD enters from the bottom of Bot'n Roll ONE A PCB.
Before  inserting  it,  place  the  16-pin  header  connector
between  the  LCD  and  the  board  with  the  longer  pins
facing down.

Insert  the LCD on the board and place the two screw
assemblies,  nylon  spacer  and  nut,  as  indicated  in  the
figure and attaching the LCD to the printed circuit board
by tightening the screws.

Check  that  the  16-pin  header  connector  has  been
"sandwiched" between the LCD and the Bot'n Roll ONE A
PCB, with the pins inside the holes of the "LCD" link on
the robot board.

Confirm that the LCD is horizontally aligned and solder
the 16-pin header connector to Bot'n Roll  ONE A PCB.
Afterwards solder the 16 pins underneath on the LCD.

The removed piece of PCB board is designed to be used 
as a unique and distinctive keyring!

©Copyright 2023, SAR - Soluções de Automação e Robótica, Lda. 34

Fig. 52: Placing the LCD

Description Component
LCD 1x16  connector
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4.2.26. USB-SERIAL CONVERTER PROTECTION CASING

The USB-Serial converter is a component that is subject
to  constant  physical  stresses  resulting  from  the
introduction and removal of the USB cable. A 3D printed
PLA  plastic  casing  was  developed  to  ”embrace”  and
protect the USB-Serial converter.  It  allows maintaining
the integrity of its structure.

Place the plastic protection on the USB-Serial converter
so the USB connection for the cable is visible. Verify that
the two holes on the bottom of the protection casing are
aligned with the holes on the robot´s PCB.

Insert  the  two  M3x6mm  screws  into  the  holes  and
tighten them using a PH1 screwdriver, threading them
into the plastic protection. Thread the screws until the
bottom of the plastic casing touches the robot's PCB, but
not tighten too much because you can grind the plastic
material!

Verify that the screws are not in contact with the welds,
it may cause short-cicuits!

The USB-Serial converter is now physically protected,
with a lot of robustness, for everyday use!
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Fig. 53: Placing the USB-Serial protection
plastic casing
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4.3. WIRING AND TESTING

4.3.1. CONNECTING THE BATTERY

VERY IMPORTANT NOTE: 

Short-Circuiting the battery might initiate a fire!

Never connect the battery to the robot before finishing
all connections! 

Before  unscrewing  the  battery  cable  from  the  "Bat"
connector, ensure that the battery is  NOT connected to
the cable! 

The battery connector is plugged in "Bat". The red wire
must  be connected to the “+” mark on the serigraphy
and the black wire to the”–“. In this case, the Polarity is
EXTREMELY important!

The wires passage from the lower part of the robot to
the printed circuit board is through the central hole on
the acrylic base.

4.3.2. ASSEMBLY ELECTRICAL CHECK

Now, connect the charged battery to the robot and verify
that the ON LED turns on and off when you use the main
switch. 

Check  with  a  voltmeter  that  the  5V,  3.3V  and  VIN
(battery  voltage)  voltages  are  present  in  the  Arduino
Power  Connector  (VIN-IOREF).  You  should  always
measure with respect to GND that corresponds to 0V.

If any of the above does not happen, it means that there
were problems during the assembling. You should fix it
before  going  to  the  next  step.  In  the  table  below  we
present some tips to help you solving the problem:
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Fig. 54: Plugging the battery wires

Fig.55: LED ON
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Possible cause / Inspection Solution

The battery is  not  properly  inserted on
the connector.

Insert the battery correctly and check that the connector
tab is latched.

The  battery  wires  are  not  properly
connected  to  the  Bot’n  Roll  ONE  A
printed circuit board.

Check  whether  the  wires  are  securely  fastened  to  the
"Bat"  connector  and  perform  a  continuity  test  with  a
multimeter.

The fuse is not inserted in the circuit. Insert  the  fuse  as  indicated  on  section  3.2.17  of  this
manual.

The fuse blew. Most likely, there is a short circuit on the board. Check
solders,  identify  and  remove  the  short  circuit  before
inserting a new fuse.

The fuse is not blown but the green LED
ON does not light up or the voltages are
not all present on the Arduino connector.

In this case, there might still  be a short circuit  but the
electric current is not enough to blow the fuse. Check the
temperature of the voltage regulators 7805 and LD33.

One or  both  voltage regulators  are  too
hot.

There is great probability of a short circuit. Check solders,
identify and remove the short circuit. There is still a small
chance of a component being damaged.

The voltage regulators do not warm up,
the  ON  LED  does  not  light  up  or  the
power connector voltages of the Arduino
are not present.

It is likely that there are bad solders and contact between
the  components  and  the  board  is  faulty.  Identify  cold
solders,  in  which  the  solder  wire  does  not  shine  and
apply the soldering iron again until  you see the solder
melt completely. Add more solder wire if necessary.

The voltage regulators did not warm up,
the  Power  connector  voltages  are
present but the Power ON LED does not
light. 
The  Arduino  connector’s  voltage  are
present  but  the  ON  LED does not  light
up.

You  should  confirm  that  the  LED  ON  is  soldered
according to the polarity, where the + corresponds to the
longest  leg.  Check  the  polarity  of  the  ON LED  with  a
multimeter.

After checking all the above possibilities,
the problem still exists.

Contact the help service on botnroll.com.
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4.3.3. INTEGRATED CIRCUITS PLACEMENT

An integrated circuit is a miniaturized electronic circuit consisting
mainly of semiconductor devices such as transistors. The number of
transistors  on  integrated  circuits  can  vary  from  a  couple  of
transistors to tens of millions of transistors.

On  the  robot,  two  DIP  format  integrated  circuits  are
used:

PIC18F45K22: 40 pins processing unit (PIC).

ATmega328: 28 pins processing unit (Arduino).

NOTE: Before  inserting  the  integrated  circuits  ensure
that the Bot'n Roll ONE A is powered OFF.

It  may  be  necessary  to  align  the  pins  of  integrated
circuits  before  inserting  them  on  the  sockets.  Do  this
carefully because the pins are fragile and can break if not
done  properly  or  bended  several  times,  becoming
irreparably damaged.

IMPORTANT NOTE: The integrated circuits have a unique
inserting  position.  In  one  of  the  edges,  a  cavity
corresponds to the printed mark on the PCB serigraphy.
Insert  the ATmega328 on  U1 and the PIC18F45K22 on
U2.
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Description Component
U1 ATmega328
U2 PIC18F45K22
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4.3.4. FIXING THE PCB ON THE ACRYLIC BASE

Fixing the robot board to the acrylic base is carried out
by using 6 sets of one 12mm nylon spacer, one M3x8
PH1 screw and one M3x4 PH1 screw.

Insert each M3x8 PH1 screw on the acrylic base from
bottom  to  top  and  screw  a  nylon  spacer  until  it  is
tightened.

Repeat for each of the six spacers.

Place the electronic board passing the motors wires by
the  centre  hole  and  attach  it  using  the  M3x4  PH1
screws thru the nylon spacers.

Tighten the screws with a Phillips screwdriver so that
there are no gaps between the PCB, the nylon spacers
and the acrylic base.

4.3.5. CONNECTING THE MOTORS

The connection of the motors is carried out on the
MotorL and  MotorR connectors.  The  left  motor
connects to MotorL and the right one to MotorR.

IMPORTANT NOTE: The motors wires have black and
red colours. Correctly connecting these wires is very
important  because  polarity  determines  the  motor
direction of rotation and the robot may not move as
expected!

The red  wire  must  be plugged  on  the “+”  and  the
black wire on “–”.
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Fig. 58: Assembling the PCB on the
acrylic base

Fig. 59: Motors connection

Fig. 57: Required parts to hold the PCB
on the acrylic base
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4.3.6. BATTERY PLACEMENT

The battery is placed on the bottom part of the acrylic
base using three Velcro strips.

Before attaching the Velcro strips check that the area is
not sticking dirty, or greasy! 

If  necessary,  use  a  glass-cleaning product  to  clean the
surfaces and let them dry properly!

Glue the two velcro strips to the battery pressing hard for
proper  attachment.  Afterwards,  remove  the  stickers
protection to place the battery on the robot.

Put the battery on the Bot'n Roll ONE A pressing again for
a good grip. Attention not to damage the components on
the robot board!

After the battery is secured with Velcro and fully charged,
attach the connector and Bot'n Roll ONE A is ready to be
programmed!

Well done! 
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5. INSTALLING THE USB-SERIAL (RS232) CONVERTER VCP DRIVER

The driver allows your computer operating system to communicate with the Bot'n Roll ONE A.

To  install  the  driver  visit  the  Bot’n  Roll  ONE  A  support  web  page  http://botnroll.com/onea/ and
download the "VCP Driver  -  Windows" or "VCP Driver  -  Mac OS X" by clicking on the correct  link
according to your operating system. After download, decompress the “.zip” file and run the application.

Every time you connect your robot to your computer using the USB cable a virtual COM port (VCP) is
created, through which the communication between your Bot'n Roll ONE A and your PC is carried out.
The programming application environment uses the port to communicate with Bot'n Roll ONE A and
therefore transfer your programs to the robot.

The USB-Serial converter used by Bot'n Roll ONE A is a  PoUSB12 product from  PoLabs and uses the
Bridge CP2102 device from Silicon Labs.

6. ARDUINO PROGRAMMING ENVIRONMENT

The  software used  to  program  the  robot  is  Arduino  IDE.  This  application  is  necessary  to  edit  the
programs in C language. It is also used to transfer your programs to Bot’n Roll ONE A.

6.1. ARDUINO IDE INSTALLATION

To install the Arduino IDE, visit Bot’n Roll ONE A support web page http://botnroll.com/onea/ and click
on the essentials "Arduino IDE - Windows" or "Arduino IDE - Mac OS X"  to download it according to
your operating system.

After downloading, decompress the .zip file and copy it to a folder of your choice on your computer.

This  folder  contains  several  sub-folders  and  files,  amongst  them,  the  "arduino" application,  the
executable that starts the Arduino IDE. The sub-folder "libraries" is also very important and contains all
the Arduino libraries. The libraries are your programming working tools.

6.2. INSTALLING THE BNRONEA LIBRARY ON ARDUINO

The  BnrOneA library developed  by  botnroll.com for  the  Arduino  IDE  contains  all  the  required
commands to control the robot. This library must be installed on Arduino IDE.

On the Bot’n Roll ONE A support web page  http://botnroll.com/onea/, download the Arduino Library
file by clicking on " BnrOneA.zip ".

Decompress the file and place the extracted folder "BnrOneA" inside the "libraries" directory that was
described on the previous section. Now you have all the required tools to successfully program your
Bot'n Roll ONE A!
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6.3. CONFIGURING COMMUNICATION WITH THE ROB OT

Before proceeding with this step, ensure you have installed the VCP driver correctly. Connect the Bot'n
Roll ONE A to your computer using the supplied USB cable. At this time, a COM port to communicate
with the robot is automatically assigned.

Open  the  Arduino  IDE,  press  the  "Tools ->
Board" option, and select the "Arduino Uno"
board.  Bot´n Roll ONE A will be programmed
as if it is an Arduino Uno.

On the "Tools -> Serial Port" option, select the
correct COM port given to Bot'n Roll ONE A.

Should no COM port  be available,  you probably  did  not  install  the  USB-Serial  converter VCP driver
correctly.

Open  the  Windows  device  manager  and  search  for  the
item “Ports (COM and LPT)”. Expand the item, you will see
all COM ports available.

“Silicon  Labs  CP210x  USB  to  UART  Bridge”  is  the
designation which identifies the COM port that “talks” to
Bot’n Roll ONE A (on this figure example  COM5 port has
been assigned).

Should the item "Silicon Labs CP210x USB to UART Bridge"
not show up on the list, you have to install the VCP driver
correctly.
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Fig. 63 COM ports on the device manager

Fig. 62: Selecting the Serial port

Fig. 61: Selecting the board to program
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6.4. LOADING A PROGRAM TO BOT'N ROLL ONE A

On the Arduino IDE application, you will find several example programs that you can load to your robot. 

Click on "File -> Examples -> 01.Basics ->
Blink" and a new window with the code of
this example will show up. 

Click on "File -> Upload" or  press  the
“arrow  pointing  right”  icon  to  send  the
program  to  the  robot.  As  soon  as  the
upload finishes, you must see the yellow L
LED flashing each second!

Clicking on "File -> Examples -> BnrOneA-> ..." you will find all the programs developed by botnroll.com
specifically for Bot'n Roll ONE A.

On "File -> Examples -> BnrOneA-> Basic -
> ..." you can find the simplest programs
whose  main  purpose  is  to  test  all  your
robot  hardware.  You  must  study  and
understand well all these small programs!

On  "File  ->  Examples  ->  BnrOneA->
Advanced -> ..." are available some more
advanced  programs  which  you  might
understand only after the basic ones.

On "File -> Examples -> BnrOneA-> Extra -
> ..." you can find programs related with
the  Bot'n  Roll  ONE  A  extras,  which  will
make your robot more versatile.
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Fig. 64: Loading an example program

Fig. 65: Sending a program to the robot

Fig. 66: Programs from the BnrOneA library
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7. BOT'N ROLL ONE A HARDWARE TEST

After your robot have successfully passed the electrical test (section 3.3.2 of this manual), it is necessary
to test all Bot'n Roll ONE A devices individually and verify they are operating correctly. You will have to
program the robot with the corresponding sample codes and perform the test described on each of the
following points listed, in the presented order!

7.1. "L" LED

Using the Arduino IDE open the example program "Blink" located on "File -> Examples -> 01.Basics ->
Blink" and program the robot clicking on "Upload". When the upload ends, you must see the  L LED
blinking every second.

If the L LED does not lights up check if there is any short-circuit or bad solders on: 
 L LED;
 R16 resistor;
 Pin 13 of the Arduino 8-SCL connector;
 ATmega328 integrated circuit socket.

Assure that you have soldered the L LED respecting its polarity. You can verify that using a multimeter or
comparing the internal connections of the LED with an identical one.

7.2. BUZZER

Load the "Buzzer" program located on "File -> Examples -> BnrOneA -> Basic -> Buzzer" to the robot.
When the upload ends, you should listen a melody emitted by the buzzer. This indicates that the buzzer
is working properly.

Should the buzzer not play the melody, check if the BUZZ jumper is placed correctly and if there is any
short-circuit or bad solders on:

 Buzzer;
 R15 resistor;
 BUZZ jumper;
 ATmega328 integrated circuit socket.
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7.3. DEBUG "LED"

Load the program "LED" located on "File -> Examples -> BnrOneA -> Basic -> LED" to the robot. When
the upload ends, you should see the LED blinking each second.

Should the LED not emit any light you must check for short-circuits or bad solders on:
 LED LED;
 R18 resistor;
 Pin 13 of the Arduino 8-SCL connector;
 SSP jumper;
 PIC18F45K22 integrated circuit socket.
 ATmega328 integrated circuit socket.

Assure that you have soldered the LED LED respecting its polarity. You can check that using a multimeter
or comparing the LED internal connections with an identical one.

7.4. LCD

Load the "LCD" program located on "File -> Examples -> BnrOneA -> Basic -> LCD" to the robot. When
the upload ends, you should see the "LCD Test OK!!" message on the LCD.

Should you not see the message, check that:
 The robot main switch is ON;
 You correctly adjusted the LCD brightness using the BR potentiometer;
 You correctly adjusted the LCD contrast using the CT potentiometer;

If you still cannot see the message on the LCD verify that there are no short-circuits or bad solders on:
 LCD 16 pins connector;
 BR potentiometer;
 CT potentiometer;
 SSP jumper;
 PIC18F45K22 integrated circuit socket.
 ATmega328 integrated circuit socket.
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7.5. PUSH-BUTTONS

Load the "Push-buttons" program located on "File -> Examples -> BnrOneA-> Basic -> PushButtons" to
the robot. When the upload ends, you can see on the LCD the button number you are pressing:

 0 if no button is being pressed
 1 if PB1 button is pressed
 2 if PB2 button is pressed
 3 if PB3 button is pressed

If any button does not work properly check that there are no short-circuits or bad solders on:
 PB1 switch;
 PB2 switch;
 PB3 switch;
 R6 resistor;
 R7 resistor;
 R8 resistor;
 SSP jumper;
 PIC18F45K22 integrated circuit socket.
 ATmega328 integrated circuit socket.

7.6. BATTERY

Load the "Battery" program located on "File -> Examples -> BnrOneA -> Basic -> Battery" to the robot.
When the upload ends, you should see the battery voltage value on the LCD.

If the voltage value is not between 9.0V and 14.0V, check that:
 The robot main switch is ON;
 The battery is charged;
 The resistor on R2 is 3.3KΩ;
 The resistor on R3 is 10KΩ;
 Placed the Zener diode Z1 with the correct orientation.

If the problem continues verify that there are no short-circuits or bad solders on:
 C1 capacitor;
 R2 resistor;
 R3 resistor;
 Z1 diode;
 SSP jumper;
 PIC18F45K22 integrated circuit socket.
 ATmega328 integrated circuit socket.
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7.7. MOTORS

Load the "Motors" program located on "File -> Examples -> BnrOneA -> Basic -> Motors" to the robot.
When the upload ends, the motors might start moving and a message is shown on the LCD describing
the movement being carried out.

Should some motor not move check:
 The robot main switch is ON;
 The battery is charged;
 The MotorL connector is tightened;
 The MotorR connector is tightened;
 The hubs are properly placed on the motors;
 The robot wheels are properly tightened to the hubs.

If the problem continues verify that there are no short-circuits or bad solders on:
 C2 capacitor;
 D2, D3, D4, D5, D6, D7, D8 and D9 diodes;
 MotorL connector;
 MotorR connector;
 U3 (L298N) integrated circuit;
 SSP jumper;
 PIC18F45K22 integrated circuit socket.
 ATmega328 integrated circuit socket.

7.8. INFRARED LED'S

Load the "_01_EmittersOnOff" program located on "File -> Examples -> BnrOneA-> ObstaclesSensor ->
_01_EmittersOnOff" to the robot. When the upload ends, the infrared LED’s will commute each second
with its respective status information shown on the LCD.

Use a mobile phone camera (without infrared filters) to check that LED's are blinking, since human eyes
cannot see this type of light.

If some of the infrared LED's do not emit any light, adjust the corresponding potentiometer ( IRD1 for
IRE1 and IRD2 for IRE2) until you see light being emitted by the LED.

If the problem continues verify that there are no short-circuits or bad solders on:
 IRE1 LED;
 Q1 transistor;
 IRD1 potentiometer;
 R13 and R24 resistors;
 IRE2 LED;
 Q2 transistor;
 IRD2 potentiometer;
 R19 and R25 resistors;
 SSP Jumper;
 PIC18F45K22 integrated circuit socket.
 ATmega328 integrated circuit socket.
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7.9. OBSTACLE SENSORS

Load the "_02_ObstaclesRead" program located on "File -> Examples -> BnrOneA-> ObstaclesSensor ->
_02_ObstaclesRead" to the robot. When the upload ends, the infrared LED’s will emit infrared light
which when reflected by an obstacle will make the IRS1 and IRS2 LED's blinking.

On the LCD, a message with the obstacle proximity indication is written and the values vary from 0 to 25:
 0 the sensors do not detect any obstacle;
 25 the obstacle is very close to the robot.

Put your hand in front of the infrared LED´s to simulate an obstacle and check that the IRS1 and IRS2
LED's blink and at the same time the respective message is presented on the LCD.

If some of the IRS1 or IRS2 LED's do not flash, verify there are no short-circuits or bad solders on:
 IRS1 LED;
 IRR1 sensor;
 R14 resistor;
 IRS2 LED;
 IRR2 sensor;
 R20 resistor;
 SSP Jumper;
 PIC18F45K22 integrated circuit socket.
 ATmega328 integrated circuit socket.

Assure that  you soldered the  IRS1 or  IRS2 LED's respecting its  polarity.  You can check  this  using a
multimeter or comparing the LED's internal connections with identical ones.

Place the robot against an obstacle, like wall or a white paper sheet, and adjust the desired distance
using the IRD1 and IRD2 potentiometers and a screwdriver.
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7.10. MOTORS CALIBRATION

Load  the  "MotorsCalibrate"  program  located  on  "File  ->  Examples  ->  BnrOneA->  Advanced  ->
MotorsCalibrate" to the robot. When the upload ends you are going to configure the necessary power
to move the motors.

Calibrating the motors must be done with the robot placed on a flat surface and using a fully charged
battery. The goal of this process is to register the necessary power for the robot to initiate movement
and the battery voltage in that precise moment. The robot will use these calibrating values to improve
motion  with  very  low  speeds  and  to  maintain  a  constant  velocity  as  battery  voltage  drops  while
discharging.

The LCD presents the power (PWM from 0 to 100) applied to the motors. Using the push-button PB1 you
will increase the power until the robot starts moving forward. In that precise moment you lift the robot
and press  the  PB3 push-button  to  save the values  in  the  robot´s  memory.  The  LCD will  present  a
message stating the data was saved.

This calibrating process must be done whenever you switch the battery for another with a different
nominal voltage or the motors for others with different nominal rotation or gear ratio.

Your Bot'n Roll ONE A is now complete and functional! Use your imagination and explore the fantastic
world of Robotics… Congratulations!
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8. EXTRAS

A  wide  range  of  components  can  be  integrated  in  your  Bot'n  Roll  ONE  A  and  thus  increasing  its
functionalities. Arduino compatible shields as wireless XBee, Bluetooth, RF, GPS, GPRS and sensors like
line follower, sonar, compass, encoders and any I2C device can be added to your Bot'n Roll ONE A and
imagination is the limit!

On the extras user manual you will find a detailed description of some of these components.  Visit the
Bot’n Roll ONE A support web page http://botnroll.com/onea/ to get the respective user manual.

You can also visit the www.botnroll.com website for more information. 

Fig.67 Extras on Bot'n Roll ONE A
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9. ANEX

9.1. BOT'N ROLL ONE A ELECTRONIC BOARD COMPONENTS LIST

Qt       Description Qt       Description
3 120 Ohm resistor 1 LM7805CT IC

13 1K Ohm resistor 1 LD33CV IC
3 3,3K Ohm resistor 1 28 pins IC socket
5 10K Ohm resistor 1 40 pins IC socket
1 1M Ohm resistor 2 Infrared LED
4 10K potentiometer 2 IR VISHAY TSSP4056 receiver
1 3mm green LED 1 POUSB12 USB-Serial converter
2 3mm red LED 2 PNP BC557 transistor
2 3mm yellow LED 1 Buzzer – Magnetic transducer 
2 22pF capacitor 1 16x2 LCD display
7 100nF capacitor 1 16 pins header connector
2 100uF 25V capacitor 4 Push buttons
1 16MHz crystal 1 Main switch

12 FR203 diode 1 10 pins female connector
1 5V1 Zener diode 2 8 pins female connector
1 3A 20x5mm slow fuse 1 6 pins female connector
1 Fuse support base 1 3x2 connector
1 Fuse support cover 2 KK 4 pins male KK connector
1 Atmega328 IC 3 2 pins connector with screw
1 PIC18F45K22 IC 2 2 pins jumper connector
1 L298N IC 1 3 pins jumper connector
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9.2. ELECTRIC SCHEMATICS
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